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Overview

NPScape is a landscape dynamics monitoring project that provides landscape-level data, tools, and
evaluations for natural resource management, planning, and interpretation (NPS 2013). This standard
operating procedure (SOP) provides guidance on how to process NPScape morphology metrics used in
classifying and describing spatial characteristics such as core vs. edge habitat. Two primary categories of
metrics are calculated from NPScape pre-processed source data: a metric based on Morphological
Spatial Pattern Analysis (MSPA) and a patch size distribution metric for both the cover type of interest
(e.g., forest, grassland, shrub) and the core areas of that cover type. NPScape offers pre-processed
morphology source data for forest and grassland cover types, estimated from the National Land Cover
Dataset, NLCD (2006; 30 m resolution; Lower 48) and the North American Land Change Monitoring
System, NALC (2005; 250 m resolution; AK, Canada, Lower 48, Mexico). Additional methods presented
in the Appendices provide guidance on how to replicate these metrics for other cover types or sources of
land cover data. Download the tool(s) and a copy of this SOP here:
http://science.nature.nps.gov/im/monitor/npscape/methods.cfm. The zip file includes an ArcGIS™
toolbox containing NPScape pattern script tools and a copy of this SOP document.

The purpose of this SOP is threefold. First, because these directions were followed in the processing of
the NPS dataset, it provides detailed documentation on the methodology used by NPScape to calculate
morphology and patch size distribution metrics for the Pattern measure. Second, this SOP provides any
user with the ability to replicate the creation of these data for custom areas of analysis. Finally, if an 1&M
park or network has a need to analyze data other than forest or grassland morphology from NLCD or
NALC, this SOP provides a processing template for recalculating focal metrics associated with the Pattern
measure.

NPScape uses MSPA to provide an objective process to estimate meaningful structural attributes of land
cover types. MSPA is based on pixel-level analysis of land cover maps, using image segmentation to
classify individual pixels of binary maps into a set of pattern types (see especially Soille and Vogt 2009).
For NPScape, we report on eight basic morphology types: core, islet, perforated, edge, loop, bridge
(=corridor), branch, and background (Monahan et al. 2012).
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For default NPScape outputs, these basic pattern types are actually aggregates of a more complex map
classification (see Appendix 2). However, when running the landscape morphology tools locally, users
can include the full array of pattern types by removing the re-classification processing step. Vogt et al.
(2007a) describe the advantages of this method over approaches that require identification and
delineation of specific patches. For NPScape, two key advantages are: (1) an ability to apply the
algorithms over very large spatial extents, and (2) the greater sensitivity of pixel-based maps and
analyses to detect changes in patterns over time (e.g., morphology is more sensitive to these changes
than area density). An additional strength is that MSPA readily accommodates different definitions of an
edge distance (i.e., the distance that defines how far ‘core’ areas are from a contrasting land cover type).

Vogt et al. (2007a) describe the process of MSPA and provide an example application. Riitters et al.
(2007, 2009) and Ostapowicz et al. (2008) examined the behavior of the measurements across scales
and in landscapes with various statistical properties. Vogt et al. (2007b, 2009) focused on the use of
MSPA to characterize landscape connectivity and identify corridors. Software used to produce the MSPA
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landscape measures is part of the GUIDOS package, available from the European Commission Joint
Research Centre (http://forest.jrc.ec.europa.eu/download/software/quidos/). Soille and Vogt (2009)
provide concise, generic, and very accessible definitions of the land pattern elements and general
application to digital images.

The 2006 National Land Cover dataset (NLCD2006) for the Lower 48 was used to generate source
morphology outputs derived for two the edge widths (<*>) in pixels (1 or 5 pixels; 30 m resolution) and
two indicator cover types (forest and grassland). The 2005 North American Land Change Monitoring
System dataset (NALC2005) for AK, Canada, Lower 48, and Mexico was used to generate source
morphology outputs derived for two the edge widths (<*>) in pixels (1 or 4 pixels; 250 m resolution) and
two indicator cover types (forest and grassland). MPSA processing is run with the NoTransition value,
causing the output to emphasize bounding edges around core areas.

This document summarizes the methods used to generate these outputs for any area of analysis from the
NPScape preprocessed NLCD and NALC forest and grassland source data. For details on how the
preprocessed source data were created, see Appendix 5.

Table
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Example morphology raster and summary statistics table.

Using an ArcGIS™ toolbox, processing steps include clipping the input morphology source raster to the
area of analysis (AOA), reclassifying the raster using an input reclassification table, calculating the total
and class areas (kmz), and producing a table summarizing area totals and percent total area for the AOA.
Optionally, patch size frequency tables are produced.

Any AOA can be used as long as its spatial reference matches that of the tool input data.

This SOP may be used with other (non-NLCD2006) tool input data if source MSPA pre-processing is
completed and specific criteria are met. For specific instructions for generating MSPA source data from
other sources or for other indicator cover types, see Appendix 5, and Appendix 3 for additional details.
The data sources were produced and tools tested using ESRI ArcGIS™ version 10.0 Service Pack 5.

Software Requirements

ArcGIS software is required to generate the metric outputs. The data sources and tools used are
assumed to be in ESRI ArcGIS™ format, version 10 Service Pack 5 or higher.

Data Requirements

Forest and Grassland MSPA Rasters

Pattern_<*>Morphology EW1 NLCD2006.tif or Pattern_<*>Morphology_EW5_NLCD2006.tif
Pattern_<*>Morphology EW1_ NALC2005.tif or Pattern_<*>Morphology EW4 NALC2005.tif
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Download path: http://science.nature.nps.gov/im/monitor/npscape/gis_data.cfm

Note: tools can be run using NALC-derived pattern inputs instead of NLCD-derived data. NALC covers
North America to the Mexico border and is available from the link above.

If you are a NPS user, you can contact the NPScape team to request a custom clipped extent:
mailto:NRSS NRPC NPScape@nps.gov

See the Frequently Asked Questions section for other data access options.

Area of Analysis polygon

AOA polygons for boundaries and 3km and 30km buffers of parks, CEC ecoregions, FWS LCC polygons,
and upstream watersheds (for selected parks) are available as NPScape datasets:
http://science.nature.nps.gov/im/monitor/npscape/methods.cfm

Alternatively, user-defined AOA polygons can be used if they conform to the input spatial reference.

Reclassification Tables:

NPScape uses reclassification (recode) tables to thematically group MSPA pattern data into morphology
classes. See Appendix 2 for details. These tables are bundled with the NPScape Pattern Metrics tools
zip file in the ToolData folder.

Input data spatial reference

For CONUS areas, the NPScape project uses USA Contiguous Albers Equal Area Conic USGS as its
standard spatial reference. A local (i.e. custom, non-NPScape sourced) area of analysis polygon may be
used if its spatial reference matches the NPScape-provided tool input raster or vector data. In this
scenario, re-project your local AOA data (if necessary) and run repair geometry on it before running the
tool(s). See the Frequently Asked Questions section for more details on re-projecting tool outputs or tool
inputs.

Input Data Pre-Processing

Determine AOA polygon

If using an NPScape-sourced AOA, download the appropriate AOA geodatabase from the link in the Data
Requirements section.

Re-project user-defined input datasets (if needed)

All user-defined, custom, non-NPScape sourced tool inputs (e.g. AOA polygon) must be in the USA
Contiguous Albers Equal Area Conic USGS spatial reference if used with NPScape-sourced tool inputs.

1. Open ArcCatalog or ArcMap. Click the search button and search for ‘Project’. Open the
Project tool and re-project your data to USA Contiguous Albers Equal Area Conic USGS.

2. Search for ‘Repair Geometry’ and run that tool on your re-projected dataset.

3. See the Frequently Asked Questions section for more details.

Download tool input dataset(s)

Download the forest and/or grassland morphology tool input dataset (for desired edge width) from the link
in the Data Requirements section. These datasets are seamless across the maximum available extent of
the source data.


http://science.nature.nps.gov/im/monitor/npscape/gis_data.cfm
mailto:NRSS_NRPC_NPScape@nps.gov
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Run PatternMorphology_Metric tool

This tool generates a file geodatabase containing Land Cover-derived morphology raster datasets and
summary tables. These outputs correspond to the NPScape pattern morphology metric.

=l L3 NLCD_Morphology.gdb

i forest THRO

22t forest_THRO _coreindicator
EE2 forest_ THRO_coreregiongroup
ez forest_THRO _indicator

@3 forest_THRO_regiongroup

forest_patch_THRO_core_stats
forest_patch_THRO_covertype_stats

forest_THRO_stats

Add toolbox to ArcMap

1.

3.

4,

Check Geoprocessing Options settings: Geoprocessing - Geoprocessing Options = ‘Overwrite
the Outputs of Geoprocessing Operations’ should be checked. This addresses an issue in
ArcGIS 10.1 Service Pack 1 when using feature layers.
Extract the tools zip file downloaded from the methods link in the Overview section above. The
following folder structure will be created:

£ ProcessedData

£ Scripts

£ ToolData

% MPScape_PatternTools

ProcessedData contains ArcMap layer files and is the default tool output folder. Scripts contains
the Python code used by the NPScape_PatternTools.tbx toolbox.
Open ArcMap use the Catalog window to navigate to the folder where the tools were extracted.
Open the NPScape_PatternTools toolbox.
Double-click on the PatternMorphology Metric tool to open it.
= @ MP5cape PatternTools

Z PatternDensity_Metric

PatternMorphology_Metric

=8
E)
b

Run the PatternMorphology_Metric Tool

1.

2.

Add input data to the map:
- Tool input data: forest or grassland morphology GeoTIFF for desired edge width
- Polygon feature class for AOA (singlepart or multipart)

Populate values for each of the required parameters in the tool:
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Source M5PA Raster
| Pattern_ForestMorphology_EW1_MLCD2006.tif
Area of Analysis Polygon

S

| THRO_ACA_Park_Multi_10km ﬂ
AOA Field

test -
Area of Analysis Name

THRO

Morphology Redass Table
G:\NPScape\Tools\Tools_Models\NPScape_Tools_Fall2012\Pattern_Tools\Tooll

Pattern Metadata File (optional)
Cutput Folder

G:\NPScapelToolsiTools_Models\MPScape_Tools_Fall2012\Pattern_Tools\Proce
Qutput Geodatabase Name

MLCD_Morphology.gdb
Output Mame

forest_edgel

[¥] Calculate Patch Size Statistics?

"

Date: January 6, 2014

] & PatternMorphology_Metric ' _'h.-? r &_' k@&lﬂ

PatternMorphology_Metric

This tool generates a file geodatabase containing
pattern morphology raster datasets and summary
tables. These pattern morphology outputs
correspond to the NPScape PFM or PGM metric,
including a pattern morphology raster, two patch
size rasters (if desired) and thematic and patch
size statistics tables. NPScape generated the
source NLCD-based morphology raster datasets
from MLCD2006 using Modified Spatial Pattern
Analysis (MSPA) thematic classes. These pre-
processed MSPA source raster datasets include
pattern morphology class values. This script uses
the pre-processed source raster datasets which
may be downloaded from the NPScape website:
http://science.nature_.nps.goviim/monitor/npscape.
See the Pattern Metrics SOP document for details.
It is also available from the NPScape website.
System Requirements: ArcGIS 10.0 Senice Pack
5, Python 2.6 or above.

Ok ] [ Cancel

] [En\rironments... ] [ << Hide Help ]

[ Tool Help

[S —

Source MSPA Raster: full path to the preprocessed NPScape MSPA source source
raster (varies by focal cover type and edge width setting)
Area of Analysis Polygon: location and name of the AOA polygon feature class

AOA Field: Text format attribute from Area of Analysis polygon. Used to label output
rasters and tables for multi-feature AOAs. If AOA polygon is a single feature, only
one output raster and output table will be generated.

AOA Name: name of the area of analysis (60 character limit)

Morphology Reclass Table: full path to the pattern reclassification table; located in
Pattern_Tools\ToolData

Pattern Metadata File (optional): full path to the pattern metadata XML file

Output Folder: full path location of output folder; defaults to
Pattern_Tools\ProcessedData; you must have write permission to this folder

Output Geodatabase Name: the output file geodatabase (must end with .gdb)

Output Name: Prefix for output raster and table names.

Calculate Patch Size Statistics flag: Determines whether patch size statistics outputs are
generated.

3. Depending on the extent of the AOA feature class, the tool may take several minutes to run.
Processing status will display in ArcMap, either as a popup or as a message in the geoprocessing
background bar. The full tool summary is found in the ArcMap - Geoprocessing > Results
popup, including error messages.

4. The clipped morphology raster, the derived indicator and grouped rasters, and the AOA statistics
and patch statistics tables will be added automatically to the map. If single-part AOA polygons
were used, only the rasters and statistics tables for the last feature will be added to the map.
Other output rasters and tables can be added manually and symbolized as grouped MSPA
classes with *.lyr files in the ProcessedData subfolder.
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5.
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If the Calculate Patch Size Statistics parameter was selected , the <Output Name>_regiongroup
and <Output Name>_coreregiongroup rasters represent patches of the cover type of interest (i.e.
forest or grassland) and core areas of that cover type calculated with an 8-cell moving window
(these are derived from indicator rasters which are also include in the output geodatabase).
See tables in the Interpretation Tips section for a description of attributes in the output rasters and
statistics tables.
Running the tool again: open Geoprocessing = Results. Double-click on the
PatternMorphology_Metric tool name to open the tool dialog. Change parameters as needed.
Change the output geodatabase name if you don’t want your original output over-written.

Quality Control

Verify dataset outputs

1.

Verify the expected rasters are created and that the AOA_NAME, CLASSNAME,
TOTAL_AOA_AREA_SQKM, AOA_FEATURE_AREA_SQKM, TAREA_SQKM, AREA_SQKM,
and PCT_AREA fields are present in AOA statistics table. If a multi-feature singlepart AOA
polygon was used, there will be rasters and statistics tables for each AOA feature, named with
the value of the AOA Field attribute. However, only outputs for the last feature processed will be
added to the map automatically.

Verify that raster edges align correctly with each other and with the source raster. Use the Effects
- Swipe tool to help verify this. Note that the NPScape layer files for pattern morphology
(ProcessedData\*.lyr) are used to standardize the raster symbology.

If outputs were generated for both pixel edge widths (by running the tool again), zoom into an
area and visually compare the outputs of the 1 and 5 cell edge width rasters. In general (but not
always), the 1 cell edge width rasters will have more Core pixels and more Perforated pixels than
the 5 (or 4) cell edge width raster. Also, the 5 (or 4) cell edge width rasters will have generally
more Edge, Bridge, and Islet pixels. Check for alignment by swiping the 1 cell edge width raster
across the 5 (or 4) cell edge width raster — the edges on the 1 cell edge width raster should align
(in general) with the outer edge of the 5 (or 4) cell edge width raster.

Look for areas of NODATA cells within the AOA. These cells are not included in statistics
summaries, so care should be taken when interpreting outputs with NODATA areas.

Verify statistics output

1.

2.

Open each value attribute table and sort the PCT_AREA column in descending order. Look for
outlying values (negative values, more than one value near 100, sum of values > 100).
By default, only the statistics table for the last feature is added to the map. Add the remaining
statistics tables, if present, and sort each PCT_AREA column in descending order. Look for
outlying values (negative values, more than one value near 100, sum of values > 100).
Open each patch size statistics table (<Output Name>_patch_*_stats) and verify the distribution
of patch sizes by creating a distribution graph: open the table, select Create Graph from the
Options drop-down. Create a vertical bar graph using FREQUENCY as the value.
Select one record from each statistics table and double-check the PCT_AREA column values by
re-calculating them by hand:

PCT_AREA = (AREA_SQKM / TAREA_SQKM) * 100
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Interpretation Tips

Output raster and statistics table attributes:
Output morphology raster attributes:

VALUE pattern class identifier

COUNT number of cells in each pattern class

CLASSNAME Name of pattern class

AOA_Name AOA name from AOA ldentifier tool parameter concatenated with AOA Field value

Statistics table attributes:

CLASSNAME Name of pattern class

TOTAL _AOA AREA SQKM Total area of the AOA in km?, calculated from raster cells

AOA FEATURE_AREA_SQKM | Total area of the AOA in km®, calculated from polygon feature

TAREA_SQKM Total class area in km?, calculated from raster cells; (COUNT *
cell size?) / 1000000

AREA_SQKM Class area in km®, calculated from raster cells

PCT AREA Percent area of class, (AREA_SQOKM/TAREA SQKM) * 100

AOA_NAME AOA name from AOA Identifier tool parameter concatenated with
AOA Field value

Due to raster cell overlap outside the AOA polygon, the raster-derived total area value will be usually
slightly larger than the polygon derived total area. In coastal or shoreline areas, the total AOA area
values will be larger than the sum of TAREA_SQKM because source tool input rasters may have areas of
NODATA values that begin a few kilometers off shore.

Patch size statistics table attributes:

FREQUENCY Number of patches
PatchSize SQKM Patch size in in km?, calculated from raster cells
AOCA_NAME AOA name from AOA Identifier tool parameter concatenated with AOA Field value

Two patch size tables are produced: <*>_patch_ core_stats and <*>_patch_ covertype_stats. The former
is the patch size frequency summary for the core patches. The latter is the patch size frequency summary
for the all covertype (i.e. forest or grassland) patches.

Frequently Asked Questions

Can/should | use a different spatial reference?

Any NPScape spatial output can be re-projected to a ‘final’ local spatial reference. For vector outputs,
Repair Geometry should be run after re-projection. This approach should be noted in explanatory or
interpretive documentation to avoid misleading the user; re-projection of an output dataset will have no
effect on area attributes in the summary table generated by the NPScape script.

All NPScape tools generate area calculations from input data. If tool input data must be re-projected prior
to running the tools, care should be taken to use a local spatial reference that distorts area minimally,
such as an equal-area projection. For CONUS tool input datasets, NPScape uses USA Contiguous
Albers Equal Area Conic USGS (NAD_83) as the spatial reference. Alaska-specific tool input datasets
are in Alaska Albers Equal Area Conic (NAD_83) while Hawaii-specific datasets use UTM Zone 5N
(NAD_83). UTM WGS84 Zone 55N is used for Saipan and Guam while UTN NAD83 Zone 2S is used for
American Samoa.

Re-projecting vector input data:
NPScape tool input vector data can be re-projected prior to use as a tool input. The source dataset
should be clipped to an extent larger than the intended area of analysis. Then, after clipping, Repair
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Geometry must be run to correct geometric errors. Finally, the clipped input can be re-projected to the
local spatial reference, followed again with a Repair Geometry operation.

Re-projecting raster input data:

Re-projection to match a local spatial reference is not recommended for raster format NPScape tool input
datasets. If re-projection is done, the source tool input raster should be clipped to an area of analysis
rectangular extent first. Then, the Processing Extent - Snap Raster environment setting in ArcGIS
should be populated with the source input tool raster. Warping will occur but should be less than it would
be without the Snap Raster setting.

Alternatively, the AOA extent could be re-projected to the same spatial reference as the NPScape input
raster followed by a repair geometry operation. Then, this polygon could be rasterized to a temporary
raster dataset with a cell size matching the input raster, setting the snap raster to the input raster to
minimize warping. Then, this temporary raster could be used to extract an area from the NPScape tool
input raster. Finally, this extracted raster could be re-projected to the desired local spatial reference as
described above.

I’m having trouble downloading the tool input dataset. Is there another way to get it?

Many tool input datasets are very large. Please contact the NPScape team to request a custom delivery
and/or a custom clipped extent: mailto:NRSS NRPC_ NPScape@nps.gov

My outputs don’t show up in my map. What can | do?

The tools use ArcGIS display layers to visualize the metric outputs. If you see ared ! by the layer name
in the map, the layer can’t find the feature class or raster to which it is linked. The most common reason
is that the Output Geodatabase Name parameter differed from what the tool script expected. Fix the
problem by clicking the red ! and navigating to the output geodatabase. Then, select the correct feature
class or raster.

If a multi-feature singlepart AOA polygon was used, there will be an output raster or feature class and
statistics table for each AOA feature, named with the value of the AOA Field attribute. However, only
outputs for the last feature processed will be added to the map automatically. Add the remaining output
rasters/feature classes and statistics tables. Use the *.lyr files in the ProcessedData subfolder to
symbolize the features.
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Appendices

Appendix 1: Known issues

Data availability
Source NLCD and NALC-derived morphology tool input data are not available for off-shore parks (e.g.

Dry Tortugas), Puerto Rico, the Virgin Islands, Hawaii, or the outlying Pacific Islands.

Data extent

Source NLCD-derived or NALC-derived raster data extend a few kilometers off the coasts and lakeshores
of North America. Therefore, coastal AOAs may not include seamless coverage of the source data. In
these areas, the AOA_FEATURE_AREA_SQKM attribute may be greater than the TAREA_SQKM value.
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Appendix 2: Reclassification tables

MSPA Reclassification (for NoTransition processing)

NoTransition
MSPA | Morphology | NoTransition
Value Class Value | Classname
0 0 Background
1 1 Branch
3 2 Edge
5 6 Perforation
9 3 Islet
17 4 Core
33 5 Bridge
35 2 Edge
37 6 Perforation
65 7 Loop
67 2 Edge
69 6 Perforation
100 0 Background
101 1 Branch
103 2 Edge
105 6 Perforation
109 3 Islet
117 4 Core
133 5 Bridge
135 2 Edge
137 6 Perforation
165 7 Loop
167 2 Edge
169 6 Perforation

Appendix 3: Using custom AOAs and/or local input data

Custom AOAs

The AOA feature class should include a text attribute with a name value for the AOA feature(s). This text
attribute should not contain /" or other special characters. The feature class can contain single or multi-
part polygons. If single-part polygons are used, an output raster and statistics table will be produced for
each feature, named with the attribute value selected in the AOA_Field parameter.

Local input data
MSPA tool input can be generated from land cover sources other than NLCD2006 and/or cover types

other than forest and grassland. Follow the instructions in Appendix 5 to produce custom MSPA tool
input rasters.

Appendix 4: Tool scripts
See Scripts subfolder for Python scripts used by the metric tool(s).
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Appendix 5: Tool input and metric data processing details

The following steps were used to process NLCD 2006 land cover into MSPA outputs for 1- and 5-pixel
edge widths (Soille and Vogt. 2009; Riitters 2011). As an example, shrub land cover from the 2006
National Land Cover Dataset (NLCD2006) is used as input to generate MSPA morphology rasters for
shrub land using the GUIDOS (Voqgt et al. 2007a, Vogt 2008) software package, ArcGIS v10. If other
land cover morphology is needed (e.q. forest, grassland, etc), the extraction mask class(es) should be
changed appropriately.

The processing steps include generating an extraction mask for the land cover thematic class of interest
(e.g. shrub land) and extracting these pixels from the source land cover dataset. Then, the extracted
raster is reclassified to produce an indicator raster for use in morphology (GUIDOS) processing.

For efficient GUIDOS/MSPA processing, this indicator raster may need to be split into tiles which are run
though the MSPA processing algorithm for selected edge widths and then mosaicked back into a
seamless MSPA output raster.

Cover Type Extraction and Indicator Raster Creation

Determine cover type of interest, extract and reclassify pixels

Determine the cover type of interest and its corresponding pixel value(s). An 8-bit, GeoTIFF format
indicator raster with two thematic classes should be produced: Value == 2 for target cover type pixels
and Value == 1 for non-target cover type pixels.

1. Load the input land cover source raster into ArcMap. Zoom to the area of analysis. Open the
Spatial Analyst - Conditional - Con tool.

2. VERY IMPORTANT: Set Environments > Processing Extent - Extent to ‘Same as Display’ and
set Environments - Processing Extent - Snap Raster to the land cover input raster:
# Processing Extent

Extent -
Same as Display - | |E;-
Taop
3090952, 764329
Left Right
-1858205.645982 -1695867.802645
Bottom
2955863.898347
Snap Raster -
| nlcd2006_landcover_level2 | |[.‘-_¢;

3. Create the interim indicator raster using the Spatial Analyst - Conditional > Con tool to extract
pixels for the cover type. The Con logic finds the target pixels and generates an interim output
raster with those pixels assigned a value equal to 2. All non-target pixels are assigned a value
equal to 1. Depending on the size of the area of analysis, this operation may take several hours
to complete.

Example shrub land syntax (python):
outCon = Con ((Raster (inputRaster) == 52) ,2, 1)

Example tool settings for shrub land (NLCD source):
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ERVA A" \ % S -
WA AEL L S WREL

-

| Inputconditional raster Il Con ]
I nlcd2006_landcover_leveld LI @
Expression (optional) Performs a conditional
“alue™ = 52 iffelse evaluation on each

of the input cells of an
Wl  Inputtrue raster or constant value P

input raster.
2 =l g

Input false raster or constant value (optional)

Il 1 = &

Cutput raster
i E:\WPScape\scratch\shrubmaskedo. tif @

- -

[ QK ] l Cancel ] [Environments... ] [ <« Hide Help ] [ Tool Help ]

T— 3 — al

4. Run Data Management > Raster > Raster Properties > Build Raster Attribute Table with the
overwrite option selected on the interim raster.

5. If the interim raster is anything other than 8-bit unsigned, use Data Management > Raster >
Raster Dataset > CopyRaster to create the 8-bit unsigned indicator raster. Click on
Environments. Select Processing Extent - Snap Raster and set its value to the extracted raster.
Select Raster Storage - Compression and set it to ‘NONE’.

Populate the options as shown to create the 8-bit GeoTIFF indicator raster:

Input Raster Copy Raster
I shrubmasked(.tif
Output Raster Dataset Makes a copy of a raster

E:\NPScape'\Seratchishrubmasked. tf dataset or loads raster
datasets into a raster

catalog.

Configuration Keyword (optional)
Ignore Background Yalue {optional)

MoData Value (optional)

[] Convert 1 bit data to 8 bit {optional)

[ Colomap to RGE {optional)

Pixel Type {optional)
8_BIT_UNSIGMED

-

QK ] [ Cancel ] [Envirnnments... ] [ << Hide Help ] [ Tool Help

6. Run Data Management > Raster > Raster Properties - Build Raster Attribute Table with the
overwrite option selected on the 8-bit indicator raster.

7. Finally, run Data Management - Raster - Raster Properties - Build Pyramids on the indicator
raster.
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8. To generate a mask for use in modifying density and morphology outputs, use the NLCD 2006
impervious surface raster and re-classify it into a mask of NLCD ‘data’ areas (0) vs nodata (1)
using Spatial Analyst Tools - Map Algebra - Raster Calculator:
Con("Landcover_NLCD2006.tif",0,1, "VALUE<127")

"E% Raster Calculator

Map Algebra expression

Conditional

-

JEEE) WEEE)

\L/\i/\il \;/\L/‘i/m Sethul

HE)E) )] v

oo ) b= 22, -

Con{"Landcover_Impervious_MLCD2006.",0,1, "VALUE<127")

Qutput raster -
D:\Workspace\Scratch\nlcddatamask, tif |@|

| OK | | Cancel | |Environmenis... | | << Hide Help |

MSPA Processing - Morphology processing logic

NPScape uses Morphological Spatial Pattern Analysis (MSPA) to provide an objective process to
estimate meaningful attributes of the spatial attributes of land cover at local to regional scales. MSPA is
based on pixel-level analysis of a land cover indicator raster, using image segmentation to classify
individual pixels of binary rasters into a set of morphology types (Soille and Vogt 2009).

In NPScape, we report on eight basic landscape pattern types: core, islet, perforation, edge, loop, bridge
(=corridor), branch, and background. These basic pattern types are actually aggregates of a more
complex set of morphology classes (see Appendix 2). Vogt et al. (2007a) describe the advantages of this
method over approaches that require identification and delineation of specific patches. For NPScape, two
key advantages are: (1) an ability to apply the algorithms over very large spatial extents, and (2) the
greater sensitivity of pixel-based maps and analyses to detect changes in patterns over time. An
additional strength is that MSPA readily accommodates different definitions of an edge distance (i.e., the
distance that defines how far ‘core’ areas are from a contrasting land cover type).

Vogt et al. (2007a) describe the process of MSPA and provide an example application. Riitters et al.
(2007, 2009) and Ostapowicz et al. (2008) examined the behavior of the measurements across scales
and in landscapes with various statistical properties. Vogt et al. (2007b, 2009) focused on the use of
MSPA to characterize landscape connectivity and identify corridors. Soille and Vogt (2009) provide
concise, generic, and very accessible definitions of the land pattern elements and general application to
digital images.

Split indicator raster into tiles (if needed)

The pattern analysis software (GUIDOS) operates only on rasters less than 10,000 by 10,000 rows and
columns. The indicator raster may need to be split into tiles of 4096 x 4096 rows and columns with a 10
pixel overlap.

1. Load the indicator raster into ArcMap. Zoom to the area of analysis. Open the Data Management
Tools > Raster > Raster Processing = Split Raster tool.
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2. VERY IMPORTANT: Set Environments - Processing Extent - Extent to ‘Same as Display’ and
set Environments - Processing Extent - Snap Raster to the land cover input raster.

3. Use the Split Raster tool to generate the tiles. Enter the indicator raster as the input raster and
choose an output folder. Be sure the other options are set as follows:

"r-% Split Raster =RAC! 2

E E

» Input Raster Spllt Raster

s Output Folder Creates a tiled output from an input

raster dataset.

Qutput Base Name

shrub
Split Method

SIZE_OQF _TILE -
Output Format

TIFF -
Resampling Techinque (optional)

MEAREST -
Mumber of Qutput Rasters {optional)
X Coordinate ¥ Coordinate

Size of Output Rasters {optional)
X Coordinate Y Coordinate
4096 4096

# Other Options
Overlap (optional)
10
Units for Qutput Raster Size and Overlap (optional)
PIXELS -
Cellsize (optional)
¥ Coordinate ¥ Coordinate

Lower left origin {optional)
¥ Coordinate ¥ Coordinate

[ ok ][ cancel |[Enviomments..|[ <<tidetiep | [  Teoltep | I|

4. Click OK to generate the tiles — this may take several hourse for large areas.

Run GUIDOS on tiles to produce MSPA tiles

The GUIDOS software generates Morphological Spatial Pattern Analysis (MSPA) outputs from the TIFF
indicator raster tiles. GUIDOS can iterate through a folder of indicator tiles. Refer to the GUIDOS >
Docs > MSPA Guide (Vogt 2008) for details. Again, GUIDOS operates only on indicator rasters less
than 10,000 by 10,000 rows and columns. If yours is larger, see the tiling section above.

1. Open GUIDOS. Set the data directory to the folder above the subfolder containing the indicator
tiles.

2. Select File > Batch Processing > MSPA and browse to the subfolder containing indicator tiles.
Select all indicator tile TIFs and click ‘Open’.

3. Setthe MSPA Batch Processing parameters as follows: EdgeWidth = 1, Transition = off, defaults
for all other parameters (results in tiles named * 8_1 0_1.tif).
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Settings for MSPA parameters and statistics: Options
|Fchnn |Edge1|"lﬁdth |T|T:|r15itinr1 |Irrtead |Statistics
8] 0] |lof ~] |lon ~]jlro ~] ]|l Cancel ]

Accept

This will generate output tiles with a patch edge width of one pixel. Core pixels will be enclosed
by edge pixels (transition == off). Click Accept to start the batch process.

Repeat steps 2 and 3 to generate another set of MSPA tiles with an edge width of 5 pixels and
transition = off. This will generate a new set of tiles named * 8 5 0_1.tif.

" ™

Settings for M5SPA parameters and statistics: Options

|Fchr1r1 |Edge1|"l.|"|dth |T|E|nsjtiun |Irrte:d |Statistics
8~ B =] ||l ] |[on ~]f[no =] |||[__Cancsl ]

Accept

=

Mosaic MPSA tiles into seamless output, if needed

Mosaicking MSPA tiles with ArcGIS: Data Management - Raster - Raster Dataset > Mosaic to New
Raster tool. For smaller areas of analysis, ArcGIS may mosaic successfully.

Using ArcGIS:

1. Open ArcMap and select the Data Management > Raster - Raster Dataset > Mosaic to New
Raster tool.

2. VERY IMPORTANT: Set Environments - Processing Extent - Snap Raster to the indicator
raster.

3. Navigate to the subfolder containing the MSPA tiles. Hold down the SHIFT key to select all the
edge width 1 MSPA TIFF tiles. Choose the output folder and enter the output raster name
(suggested format: <cover type> 8 1 0 1.tif). Ensure the Pixel Type is set to
8_BIT_UNSIGNED.

4. Depending on the area of analysis, the mosaic process may take several hours to run.

5. Repeat step 3 to mosaic the edge width 5 tiles. Change the output raster name to <cover

type>_8 5 0 1.tif.
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